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Executive Summary 
This document was prepared to introduce users to the Alvéole PRIMO tool in 

the ExFab at the Stanford Nanofabrication Facilities. The tool as officially added to 
the ExFab in December of 2017, and aside from the brief user guide on the SNF 
website, there are very few published resources for working with the device. For that 
reason, the primary aim of our E241 project has been to develop a manual that will 
guide a novice in using the tool. This document cannot replace in person training 
and mentorship, but rather should be used as a starting point in process 
development.  

 
We recommend that potential tool users start by looking at the “Quick-start 

guide” in Section 1--meant to give the big picture overview of creating a first protein 
pattern. Then, it is beneficial to review the process flow as laid out in Section 4.1. This 
diagram shows a cross section of a sample substrate throughout processing to 
highlight the surface level changes accompanying each step. Some users may then 
find it helpful to review the mechanics of the system by reading Section 3.1. In this 
system overview we describe the mechanism by which PRIMO is able to achieve 
micron scale resolution.  
 

For those readers that aren’t sure if protein patterning is necessary, we 
recommend reading Section 2. This section gives a brief overview of the importance 
of protein patterning and some examples of its application in modern 
mechanobiology literature. Stanford students and post-doctoral scholars wishing to 
learn more can inquire about the ME/BioE/BIOPHYS 342A class: “Mechanobiology 
and Biofabrication Methods.”  

 
To summarize the results of our 10-week long project: protein patterning is a 

task that requires fine tuning. There are many parameters to be adjusted, some 
more important than others. In our experience, we found these ‘tips and tricks’ to be 
most helpful, and we expand upon these ideas throughout the report: 

● “Masks” can be made with ImageJ (open source software, popular in biology 
● We recommend a minimum feature spacing of 15 pixels (~4.2 um) 
● Glass must be very clean and particle free 
● Plasma treating the glass improves the quality of patterning 
● Maintaining PEG hydration throughout handling is critical  
● Consideration must be given to protein solution: 

○ Protein concentration  
○ pH 
○ salt concentration 
○ Incubation time and temperature 

● 100% power, 60 second duration is a good starting point, but individual users 
may want to optimize these parameters to improve 

○ Uniformity 
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○ Resolution 
● PRIMO is easier to learn and has fewer barrier to entries that lift off or 

microcontact printing 
● For large scale operations, Heidelberg lift-off (not direct writing) may be 

quicker. Refer to Section 7 for considerations needed before this possible. 
● Future users may want to try diluting the PLPP and increasing exposure time 

as an approach to improving minimum feature size 
 
Many scholars have invested significant energy into developing the set of 

knowledge presented here. Erica and Joy are both co-advised by Beth Pruitt, 
Professor of Bioengineering--whose group has made great efforts in developing 
devices with protein patterns for mechanobiology assays. We are grateful for all of 
the mentorship we have received from our labmates, including but certainly not 
limited to: Gaspard Pardon, Leeya Engel, Sasha Denisin, Robin Wilson, Alison 
Schroer, Alexandre Ribiero, Jens Moeller, and alumni of the Stanford Microsystems 
for Mechanobiology group, PI Beth Pruitt.   
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1. Quick-start Guide

 

 

5 



 

2. Background: Why pattern protein? 
Growing cells or tissues in vitro, away from an organism, is a common 

approach to studying biological systems. The fact that the cells are growing outside 
of the native environment is specifically why this approach is so appealing: it allows 
us to directly probe the role of the cell’s microenvironment. Regardless of the 
scientific questions being asked, typically the cell’s must be attached to a substrate 
such as a cell culture dish or hydrogel. Generally, a cell will only attach to this 
substrate if the substrate has been functionalized with a protein. Figure 2, below, 
displays a highly simplified model of how this type of adhesion works. A generalized, 
eukaryotic cell attaches to its extracellular environment through integrin binding 
sites. These integrins are a special type of protein made by the cell that extend from 
the cell’s membrane into the microenvironment. The integrins are often complex 
proteins that have binding sites for specific protein types. In culturing cells, an 
important step is to determine the protein to which a specific cell type will bind. 
Examples of proteins include fibronectin, Matrigel, and gelatin. 

 

Figure 2.  Cells rely on extracellular proteins for anchoring.1 

Although scientists have been culturing cells and tissues on protein for 
decades, more recent work has placed an emphasis on how the micro-mechanical 
environment affects biology. This field is called “mechanobiology.” Being able to 
control the location of protein in the 2D or 3D space around the cell has allowed 
scientists to explore cell morphology, development, and mechanical output. Figure 
3, below, presents three different applications of protein patterns. Figure 3A shows 
cells, labeled with green fluorescence, attaching to a variety of patterns, shown in 
red fluorescence. Figure 3B shows cardiomyocytes, heart muscle cells, grown on 
protein patterns with varying aspect ratios. Using traction force microscopy, Ribiero 
et al. see that pattern aspect ratio influences force production. Figure 3C, from 
Grevesse et al., shows an example where patterns were used to encourage a 
standard cell morphology. Had the cells not been cultured on well defined protein 
patterns, the cell shape would difficult to tune. This approach allowed the 
researchers to obtain more repeatable and tunable mechanics measurements.  
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Figure 3. Examples of protein patterning in mechanobiology literature. 
A) Cell morphology controlled by protein patterns2. B) Cardiomyocyte 
output varies with protein pattern aspect ratio 3. C) Patterning neurons 
improves the repeatability of mechanics assays 4.  
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3. An Introduction to the PRIMO Tool 
 

 
 

 

Figure 4. The Alvéole PRIMO. A) The PRIMO tool shown with a generic 
inverted light microscope5 B) Light path from the UV laser source, to 
the PRIMO (DMD) to the glass coverslip6. C) The Alvéole PRIMO 
workspace in the Ocean room of the ExFab at the SNF.  

3.1 System Overview 
The Alvéole PRIMO system is comprised of the tool itself, Figure 4A above, the 

proprietary photoinitiator PLPP, and the control software Leonardo that operates as 
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a plugin for the open source software Micro-Manager. For a visual demonstration of 
how the system works, we refer the reader to Section 1 of this document. A generic 
process flow for working with the PRIMO is also available for reference in Section 4.1. 
Figure 4B, adapted from Strale et al., shows the path traveled by the UV light as it 
moves from source to the final location of the glass coverslip. When the light enters 
the DMD, the array of mirrors selectively reflects the UV light based on the user’s 
specified pattern. The Leonardo software controls the positioning of the DMD 
mirrors. The software also allows the user to specify the number of times to expose 
the pattern on the substrate. If the user specifies more than one, the Leonardo 
software controls the motorized stage (Figure 4C) so that the substrate 
automatically moves to the next pattern location.  

3.2 Health & safety warnings 
● Laser - do not look into the laser’s light path.  
● PLPP - must wear gloves as PLPP can cause irritation if it comes in contact 

with skin, eyes, or mucous membranes. Acute toxicity by ingestion.  
● Never pipette by mouth. 
● Keep fingers away from the motorized stage immediately following power 

up--the microscope automatically moves the stage during this period. 

3.2 Cautions 
● Be careful when raising the objective so as to not ram the objective into the 

sample. After each use, we recommend setting the objective to lowest z 
height.  

● Use caution when tilting the condenser between positions  (i.e., gently tilt it 
back rather than letting it fall back on its own) 

● Never put oil or water onto the objectives  
● When possible, position the stage using the controller rather than the yellow 

knobs 

3.3 Interferences 
● The focal plane of the objective must be on the surface of the substrate where 

the PLPP-UV interaction is desired. It is recommended that to orient or 
sandwhich sample such that light path goes through the minimum number 
of layers.  

● Conducting a proper calibration of the device before using a new substrate is 
critical to achieving high quality results. 

● At times, Leonardo software or MicroManger stop working. Recommended to 
exit micromanger and restart. Saving the calibration file is a good practice and 
will save time in case of software stops during a session.  

3.4 Personnel qualifications & responsibilities 
● Users should be comfortable operating an inverted microscope in brightfield 
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3.5 Equipment and supplies 
● Glass coverslips (22x22mm) 
● Straight Tapered Flat Point Tweezers  
● Acetone 
● Isopropanol Alcohol   
● DI or Milli Q Water  
● Silicone spacer ( wells made with a biopsy punch)  
● Plasma Asher  
● Petri dishes/ 6-well plates  
● 0.1 mg/ml (poly(l-lysine)-graftpoly(ethylene glycol) (PLL-g[3.5]-PEG (2kDa), 

SuSoS AG 
● PBS (1X, pH 7.4) 
● Individual pipettors (10uL, 20uL) 
● Pipette tips 
● PLPP (1X, Alveole)  
● CAD drawing of pattern of interest 
● Protein  (ex. Peanut Lectin, 500ug/mL ; ELP-RGD 100 ug/mL) 
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4. Procedure for using the Alvéole PRIMO 

4.1 Process flow 
 

 

Figure 5.  Basic process flow for patterning protein with the Alvéole PRIMO tool. 

 
Figure 5, above, is meant to demonstrate the basic process flow required to 

selectively pattern protein on glass. We encourage potential users to go through 
each of the steps as detailed throughout Section 4. In brief, we suggest the following 
when considering this overview: 

● Clean coverslips - Rinse each glass slide starting with Acetone, Isopropanol 
Alcohol, and thoroughly rinse in DI water. Use Nitrogen to air dry, followed by 
5min on 180C hot plate.  

● Plasma treatment - 20 seconds at 80W 
● Pll-g-PEG - 100ug/mL in 1X PBS (pH 7.4), 1hr at room temperature (RT) 
● It is important to rinse thoroughly between steps 4 and 5, 7 and 8, and in step 

9. This will ensure (1) properly washing away any excess (2) properly wash away 
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any component not adsorbed. 5 times rinse in PBS (1X, pH 7,4) is 
recommended.  

● Although omitted from the graphic above, we have had success in sterilizing 
the device for cell culture by placing it under a UV lamp between steps 7 and 
8 for at least one hour. However, we anticipate those results will vary greatly 
between UV lamps, substrates, and cell types. Some cell types are notoriously 
more sensitive to contaminants. Be sure to check that the UV lamp being 
used is the proper wavelength for lysing DNA and that it is within its 
acceptable lifetime.  

4.2 Making a pattern 
There are many ways to make a suitable pattern to use with the PRIMO tool. 
Whichever method is used, the image must be: 

● 8 bit 
● .tif format 
● 1824 x 1140  

 
In our hands, the easiest approach to drawing a pattern was to use the NIH 
open-source software ImageJ or FIJI (FIJI is just ImageJ). To do this: 

1. Open ImageJ 
2. File -> New -> Image 

a. Type: 8-bit 
b. Fill with black 

i. Black = 0; no UV exposure 
ii. White = 255; full power UV exposure 

iii. Gray = 1 - 254; Leonardo will accept an image with any pixel 
having a value between 0 and 255. 

c. Width: 1824 pixels 
d. Height: 1140 pixels 
e. Slices: 1 

3. Use any of the region of interest tools to specify a shape.  
a. Use the left and right arrows to move the selection 
b. The floating toolbar will display X and Y positions, as well as height and 

width of the selection 
c. When running on Mac OSX, holding the option key while using the left 

and right arrows will allow you to change the size of a rectangle one 
pixel at a time.  

4. Edit -> Invert: After this step the region of interest should have become white*.  
 
An alternate approach, one which we did not try but might work in theory, is to use 
MatLab to create two-dimensional, 8-bit array of size 1824 and 1140. You could then 
assign a value between 0 and 255 to each element in the array. Elements with a 
value of 0 will see no UV light. Elements with values between 1 and 254 will be on the 
gray scale, and those with a value of 255 will read as pure white. This variable would 
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then need to be exported into a .tif format. It is possible that you could achieve a 
similar outcome using Python. 

4.3 Making PDMS templates 
The PDMS template plays a very important role throughout the patterning 

process. During PLL-g-PEG incubation it keeps the solution within the region of 
interest, and similarly so for the PLPP and protein steps. As such, it is very important 
that the PDMS is securely attached to the glass. For that reason we suggest the 
following: 

● Work with the PDMS in a very clean environment--any dirt or oils will prevent 
the PDMS from sticking to glass 

● Use Scotch tape to clean the PDMS  
● Try plasma treating the PDMS before applying it to the glass 
● Apply gentle, even, firm pressure to the PDMS to promote full PDMS-glass 

bonding 
There are multiple ways to make the PDMS template, as it is also possible to 

purchase templates directly from Alvéole. Users may find it easiest to cut their PDMS 
membranes to the desired shape using a laser cut. For our E241 experiments we 
used a sheet of very thin PDMS that ships with protective plastic on both sides, 
shown in Figure 6, below. We then did the following: 

1. Thoroughly clean the working surface with 70% ethanol  
2. Mark the cut lines on the outer plastic with a pen 
3. Use scissors to roughly cut the desired area 
4. Peel away the protective plastic 
5. Use an X-acto knife or whole punches to cutter the inner template area 
6. Apply the sticky side of Scotch tape to the PDMS to remove debris and 

residue 
7. Plasma treat the PDMS prior to bringing it into contact with the glass  

 

 

Figure 6.  Example of PDMS template making supplies.  
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4.4 Preparing the substrate 
A well prepared substrate is the key to a quality protein pattern. This cannot 

be emphasized enough. Any particulate or residue on the surface will interfere with 
the protein adsorption and will thus reduce the uniformity and potentially the 
resolution of the resulting pattern. Precise steps for preparing the substrate will vary 
between users and applications. It will be important that all users devote time to 
developing a technique that is best suited for their application. For our E241 
experiments where we used glass coverslips as our substrate, we followed these 
steps.  

1. Clean the coverslips with double distilled water (ddH20), followed by 
acetone, methanol, isopropyl alcohol, and then ddH20. After removing 
the coverslips from the final ddH20 wash the water should freely roll 
away from the surface. If the water clings to the surface then the 
surface is still dirty and this process should be repeated. 

2. Thoroughly dry the coverslips by placing them on a hot plate set to 
180˚C for 5 minutes. This should be done in a protected environment so 
as to prevent particles in the air from falling onto the coverslips. 

3. Plasma treat the coverslips for 20s and 80W (durations and power 
settings will vary between plasma ashers).  

 
Here we have found it useful to use the same approach to handling the substrates as 
when working with silicon wafers: never speak to an open wafer. Whenever 
transporting the substrate, it is best to cover the substrate and to protect it from the 
surrounding environment. 

4.5 Powering up the tool 
1. Turn on the computer 
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2. Turn on the Sola Light Engine rear switch 

 

3. Turn on the Sola Light Engine front switch and the Leica CTR advanced 
microscope power switch 
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4. Turn on the Hamamatsu camera 

 

5. Turn on the Alvéole PRIMO rear power switch 
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6. Turn the Alvéole PRIMO laser key to the ‘on’ position 

 
 
 
 

4.6 Calibration 
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Figure 7.  Calibration setup for the PRIMO tool. The white arrow is 
pointing to a transparent substrate of the same thickness as the 
desired sample, coated with yellow highlighter ink. At the center of the 
larger circle is a light green dot. This is the UV light shining from the 
PRIMO tool onto the surface.  

As described in Section 3.3, proper device calibration is essential to achieving quality 
results. In this step, you are guiding the Leonardo software so that it can calculate 
the needed values to focus the UV light on the surface of your substrate. To calibrate 
the PRIMO tool: 

1. Calibration requires having a substrate of the same transparency and 
thickness as the one you will use for your exposures. An example is shown in 
Figure 7 above: 

a. Use the yellow highlighter near the PRIMO tool to mark the surface 
thoroughly 

b. Mount the substrate on the stage as shown in Figure 7 
c. Raise the 20x object to approximately the height shown in Figure 7 

2. After powering on all of the equipment, open Micro-Manager 
3. Menu -> Tools -> Devices 

a. Change transpose X value from 0 to 1 
b. Change transpose Y value from 0 to 1 

4. Menu -> Plugins -> Leonardo: the Leonardo software should open and will 
guide you through the calibration process as shown in Figure 8 below. 

a. When prompted, use a magnification value of 19.8 
b. In the black square shown in Figure 8, the white PRIMO logo may not 

be readily visible. Often this is because the 20x objective needs to be 
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raised significantly. Please be extremely cautious when doing so in 
order to avoid crashing the objective into the glass coverslip.  

c. Use the fine control on the remote microscope controller to bring the 
PRIMO logo into focus 

d. Adjust the laser power until no pixels are saturated (i.e., white). In our 
hands this was typically around 30%. 

e. Keep the exposure time set to 25 ms 
f. When ready, click ‘ok.’  
g. Be sure to save the calibration by going to the Leonardo software menu 

-> Parameters -> Calibration tab -> ‘Save’ 
 

 

Figure 8. A screenshot from the Leonardo software during the 
calibration process.  

4.7 Applying the PLPP 
Once calibration is completed, it is time to remove the PBS from your 

substrate and to replace it with PLPP. During this step it is very important to keep 
the surface hydrated, but to simultaneously not dilute the PLPP--all while not 
disrupting the PDMS template. This is a challenging task that will require practice. 
We suggest practicing with PBS a few times before using PLPP. Always use a pipette 
to apply the PLPP. Approximately 10 µl of PLPP is sufficient for an area of diameter 
.75 cm. Once the PLPP has been applied to the substrate, mount your substrate onto 
the stage in a way similar to that shown in Figure 7. Be sure that the surface is level 
and secure.  
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4.8 Exposure 
In order to achieve the best quality you will need to adjust the focal plane so 

that you are focused on the desired substrate surface. Figure 9, below, shows the 
Leonardo software during this step.  

1. Using the microscope control panel, set the brightfield shutter to open and 
increase the white light intensity to ~ 50.  

2. In the Leonardo software, load your pattern using the ‘Browse’ button on the 
left hand side of the window. It will appear in white in the uppermost left 
corner of the screen. Click the icon that is a set of squares next to the 
magnification buttons to make the pattern appear in red above the field of 
view. 

3. In the Leonardo software, locate your desired position. We used our PDMS 
template as a reference point in determining the location of our focal plane. 

4. Indicate the number of patterns you want to complete (1 pattern = 1 column 
and 1 row). Use the preview button to see how large of an area this pattern will 
span.  

5. When you’ve positioned your substrate, using the microscope controller: 
a. Keep the brightfield shutter open 
b. Turn down the light intensity to zero 
c. Set the Z position  
d. Set Z-AFC to ‘Hold’ 

6. When you are ready to expose, in the Leonardo software: 
a. Adjust the laser power 
b. Adjust the duration 
c. Press the ‘Play’ button 

7. Verify that the laser light has turned on by holding a piece of white paper 
above the condenser lens. You should see a blue spotlight on this piece of 
paper. 
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Figure 9.  Leonardo software during pattern positioning.  

4.9 Removing the PLPP 
Following exposure, use the pipettes to replace rinse away the PLPP with PBS, 

but be careful to maintain surface hydration. We recommend rinsing 5x with 1X PBS, 
though this is a point upon which other users may vary.  

4.10 Tool shutdown 
When you have finished using the tool, shut down the equipment in this order 

1. Exit Leonardo 
2. Exit Micro-Manager 
3. Shut down the computer 
4. Turn the Alvéole Laser key to the ‘off’ position 
5. Turn off the back laser switch 
6. Turn off the Hamatsu camera 
7. Turn off the Leica CTR Advanced power source 
8. Turn off the front switch of the Sola Light Engine 
9. Turn off the back switch of the Sola Light Engine 

4.11 Sample storage 
Between removing the PLPP and applying the protein it is very important 

that the PLL-g-PEG layer be hydrated. The PEG’s bio-passivation properties rely on it 
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being hydrated. Some members of our research group (Microsystems Lab) have 
been able to store the passivated devices in PBS at 4˚C for one week without 
trouble. We recommend users experiment with this parameter to find their optimal 
solution.  

4.12 Sterilization 
Cells and tissues need a sterile environment for culture. Unfortunately, it isn’t 

possible to preserve the sterility of the substrate and the PDMS throughout 
processing. In our experience, one method to sterilizing the substrate after 
processing is to place it under a UV lamp for at least one hour. Of course, the UV 
lamp needs to emit the correct wavelength in order to breakdown the DNA of 
whatever potential contaminant you are dealing with. The duration of UV exposure 
will also vary depending on the age of the UV bulb, intensity, and distance from the 
substrate. Individual users will need to experiment with this parameter in order to 
find the ideal solution for their situation. In our experiments we found that placing 
the substrate in a biosafety cabinet with the UV light on for 1 hr was sufficient, 
though others in our group have required doing the same thing overnight to 
achieve acceptable results.  

4.13 Protein application 
When the sterilization step is complete and you are ready to apply your 

protein, you will need to exercise care when removing the PBS so as to not let the 
surface dry out. If the surface dries out, and then you apply protein, the protein will 
adsorb to undesired regions of the surface. That is, the PLL-g-PEG loses its 
biopassivation properties when it is dehydrated. As with the PLPP application, this is 
a tricky process and will require practice. It may be beneficial, for this reason, to start 
with a protein concentration higher than normal so that it will not be overly diluted 
when applied to the surface. Protein incubation times and temperatures will vary 
between substrates and protein types. In our experiments with peanut lectin we 
were able to achieve good results by allowing the protein to sit on the substrate for 
at least 30 min at room temperature. After this time you will need to thoroughly 
rinse the surface to clear any excess protein. Excess protein can tend to make the 
cells clump together, which is typically not desired.  
 

Protein chemistry is outside the scope of this report, but there is extensive 
literature on working with protein. As general tips to potential users, here are some 
things we have found to be very important: 

● pH 
● Salinity 
● Storage conditions 

○ Make your dilution 
○ Aliquot to 100 µl 
○ Freeze at -20˚C 
○ Thaw until just before use 
○ Vortex/pipette up and down just prior to use 
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● Caution, some proteins are very temperature sensitive and prone to clumping 
and therefore one would need to: 

○ Work with the protein on ice 
○ Never pipette vigorously or vortex  
○ If pipetting only use a 1000 µl pipette tip 

 
Due to the dramatic variation in results achieved between users and protein 

types, we highly recommend that all users plan to first work with a fluorescently 
labeled version of their protein to work out the details of their own protocol.  
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5. Using Fluorescently Labeled Protein to Assess Pattern 
Quality 

 
It is recommended to visualize protein patterns using fluorescently labeled protein. 
This can be achieved by protein having a fluorophore attached or by spiking in some 
other fluorescently labeled protein to your protein of intrest. Image protein pattern 
under a fluorescent microscope and save image. Depending on protein adsorbed 
and fluorophore, adjust the exposure time (~ 10ms - 500ms) and dynamic range.  
 
For the purposes of this project, we were intrested in quantifying the following 
parameters: area uniformity, resolution, and line width consistency. The table below 
describes the analysis output and the ideal trend desired for each parameter. The 
images within the table depict the area/line drawn in imageJ for analysis. Imaging 
scripts written in all in Matlab. 
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6. Project Overview: E241 - Autumn 2017 
 
Below is table describing our project motivation and objectives.  

  

6.1 Peanut Lectin on Glass 
 

 
Laser power and duration do not affect average protein signal from patterns.  
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High laser power and longer duration may improve signal unformity.  

 
 
 

 
Shorter expsure duration results in narrower lines.  
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Proof of concept: cells can grow on PRIMO patterns 

 
 

6.2 Peanut Lectin on TEM Grids 
 
● With some handling practice, the grids (12 nm carbon on Au grid) can 

withstand all treatment steps 
● Imaging the grids presents the greatest challenge  
● For future users: 

○ Try first on glass coated with carbon. Removes handling complexity. 
○ Adjust protein incubation time 
○ Consider protein pH & salinity 
○ Use critical point dryer after protein incubation if imaging dry. 
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TEM Grids imaged after all steps in protocol detailed above. 

6.3 ELP-RGD on Glass 
● Confirmed feasibility.  Used standard parameters (100% Power, 60sec 

exposure), n=3 coverslips. Imaged below, scale bar 20um. 
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7. Project ideas 
Below are potential project ideas using PRIMO ALVEOLE.  

● Characterization of alignment between multiple proteins 
● Characterization of protein gradients 
● Expansion of substrates used 
● Expand into covalent chemistry (currently only adsorption based) 
● Expand into different biopassivation components (degraded by PLPP + UV 

light) 
● Alignment issues for large patterns. There appears to be offsets between each 

300x500um exposure region. This could be a software issue, but there may be 
way to work around this manually. 

 
Note: PRIMO Alveole version 1 was used for work descirbed here.  At the time of 
writting report, the tool purchase was finalized. The purchase will be for PRIMO 
Alveole version 2. Thus some of the ideas suggested above may be improved in 
version 2.  
 
Below is a table detailing considerations for other ExFab tools if objective is 
patterning using the same principles of PRIMO Alveole. The objective of this table is 
determine potential concerns, sample size limitations and resolution. The table 
below also includes two other methods for 2D protein patterning for a reference 
comparison. For a more detailed comparison between microcontact printing and lift 
off technique we refer the reader to following article (Moelle, J., Denisin, A. K., et al, 
plosONE Dec 2017). https://www.biorxiv.org/content/early/2017/02/24/111195  
 

Method/Tool  Sample 
Size 
Limitations 

Resolutio
n  

Comments  

Microcontact 
printing 

--  ~um 
 
Limited 
by PDMS 
stamp 
features 

Requires protein to be dried and then transfered 
onto glass.  
 
Can have  a high degree of variability from 
pattern to pattern.  

Lift off 
patterning 
(LOP) 

--  ~um 
 
Limited 
by s1818 
structures 

Protocol briefly consists of S1818 patterns on 
glass, biopassive pll-g-peg, NMP 
(N-Methyl-2-pyrrolidone) to lift off S1818 
structures and backfill of protein.  
 
Critical steps require a hydrate 
substrate;,proteins never dried 
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Repetable patterns of high quality (protein 
transfer efficiency, pattern accuracy). 

Primo Alveole  Limited to 
microscop
e stage 
holder size 
 
22x22mm  
3inx1in 

1.2um  Down-top tool. Light comes from the bottom.  
 
Critical steps require a hydrate substrate; 
proteins never dried. 
 
Repetable patterns of high quality (edge 
sharpness, uniformity). 
 
Multiple proteins 
 
*no other available commercial tool as of 
December 2017 

Heidelberg 
Maskless 
Aligner (SNF 
setup)  

Up to 6in 
wafer 
 
100um-6m
m thick 
substrate 

1um  Top-down tool. Light comes from the top.  
 
Concerns: 
Major concern: Focusing mechansim relies on 
back pressure. This could be potential issue 
since plpp and pll-g-peg layer need to hydrated.  
 
Tool at SNF uses 405nm wavelength. 375nm 
available for purchase.  This could be potential 
issue since PRIMO laser wavelength is 395nm. 
Need to test is PLPP is cleaveable at 405nm. 
 
Liquid falling into the chuck or camera (both 
located in the bottom). This could be potential 
issue since plpp and pll-g-peg layer need to 
hydrated.  
 
Overall, doesn’t lend itself to patterning using 
pll-g-peg and plpp as in PRIMO. If desired, could 
be possible with lots of modifications.  
 

Nanoscribe 
(SNF setup)  

Up to 4in 
wafer 

~500nm  Depending on the operating mode, substrate 
has working distance limitation. This would limit 
the substrate thickness 
Standard Mode: light → substrate with 
photo-active resist on top. Working distnace of 
300um. 
Dip-in laser Mode: objective is submerged in 
resist. Requires a 0.05 diffraction index change 
to focus on substrate.  
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Concerns: 
Tool at SNF uses 780nm 2-photon exposure 
system (390nm).  This could be potential issue 
since PRIMO laser wavelength is 395nm.  
 
Major concerns: Working distance and 0.05 
diffraction index change required 
 
 
 

Optomec 
(SNF setup)  

Up to 6in 
wafer 

>15um 
 
 

Aerosol jet, dispensing 3-5um droplets towards 
substrate 
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Appendix 
 
Matlab scripts used in analysis.  For further image automation refer to (Moeller, 
Denisin, et al refence).  
 
%% Uniformity 
% 11.14.2017  
% Erica Castillo 
 
%Import Intensity vs Position data  
% Home>Import data> Excel File remove first row 
% datapos  vs dataint 
 
%calculate average 
average=mean(dataint); 
 
%calculate standard deviation 
stdev=std(dataint); 
 
%plot 
Vavg=dataint.*0 + average; 
Vpstdev=dataint.*0 + average + stdev; 
Vmstdev=dataint.*0 + average - stdev; 
 
plot( datapos,dataint,datapos,Vavg,'-.r', datapos,Vpstdev,'--r',datapos,Vmstdev,'--r') 
legend('line profile','average','+1 stdev','-1 stdev') 
 xlabel('horizontal position (pixels)') 
 ylabel('intensity') 
 
%% Resolution 
% 11.14.2017  
% Erica Castillo 
 
%Import Intensity vs Position data  
% Home>Import data> Excel File remove first row 
% datapos  vs dataint 
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plot(datapos,dataint) 
legend('line profile across pattern') 
 xlabel('position (pixels)') 
 ylabel('intensity') 
  
% dataintSmooth=smooth(dataint); 
% plot(datapos,dataintSmooth) 
 
%MANUALLY: Find average noise by taking start/or end of vector 
noise=mean(dataint(1:30,1)) 
 
findpeaks(dataint,datapos,'MinPeakDistance',0.0001) 
 
%MANUALLY input peak values 
%disregard some peaks visually, can play with the last entry to findpeaks 
%function to get add/delete peaks 
Peakint=[1870,1454,1049,348]; %taken visually using data cursor,last entry is where 
not distinguishable 
SNR=Peakint./noise 
 
%output SAVE : SNR  
 
 
%% Line Width Uniformity 
% 11.14.2017  
% Erica Castillo 
 
%Import Intensity vs Position data  
% Home>Import data> Excel File remove first row 
% datapos  vs data 
 
% adapated from 
https://www.mathworks.com/matlabcentral/answers/310113-how-to-find-out-full-wid
th-at-half-maximum-from-this-graph 
 
%% FWHM  
% Find the half max value. 
halfMax = (min(data) + max(data)) / 2; 
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% Find where the data first drops below half the max. 
index1 = find(data >= halfMax, 1, 'first'); 
% Find where the data last rises above half the max. 
index2 = find(data >= halfMax, 1, 'last'); 
fwhm = index2-index1 ; % FWHM in indexes. 
% OR, if you have an x vector 
fwhmx = datapos(index2) - datapos(index1); 
 
 
%Visualize Plot 
plot(datapos, data, 
datapos(index1,1),data(index1,1),'*r',datapos(index2,1),data(index2,1),'*r') 
legend('line profile across width','FWHM p1','FWHM p2') 
 xlabel('position (pixels)') 
 ylabel('intensity') 
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